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The Activity Tracking Form (ATF) is designed to track and compile major program
activities by objective, date, type of activity and reach. Major program activities are
defined as direct education interventions where participants (either Food Stamp
Nutrition Education (FSNE) eligible consumers or intermediaries) are actively engaged
in the learning process and indirect education interventions such as the distribution of
information and resources (including promotional events). This document allows the
Research and Evaluation Unit and your Program Manager to verify that program
activities are reported in a quantitative, accurate manner. These numbers are compiled
for all contractors and submitted to United States Department of Agriculture (USDA)
annually. The ATF is a helpful tool for completing both the Semi-Annual Activity
Reports (SAAR) and progress reports because it allows you to keep track of major
Network-related activities for the previous six months in a chronological fashion by
SAAR category and Scope of Work (SOW) objective. Only Federal Share activities,
those conducted as part of your Network SOW, should be tracked on this form. The
numbers for the specific activities on the ATF must match the numbers entered
on the SAAR for the specific activities listed (e.g., consumer nutrition education
classes).

The current version of the ATF (Excel worksheet) contains sheets for up to 25
objectives. As activities are entered, the columns will automatically total at the bottom
of each sheet. In addition, the ATF Summary page will automatically maintain totals for
all SAAR-related entries from all sheets. Use the totals from the ATF Summary page to
complete the SAAR. There is a separate Media Summary page for tracking media-
related activities, and the totals from this page will also be entered in the SAAR. There
are columns available for you to track non-SAAR activities on each Objective sheet and
a page designed specifically for tracking your Infrastructure Objective activities. The
numbers for the non-SAAR activities and the Infrastructure Objective do not total on the
ATF Summary page; however, this information may be used in completing the
“Progress to Date” columns in your Annual Progress Report.

If you are using an ATF template from a previous reporting period, please be sure to
update the reporting period indicated in the Header to correspond with the current
reporting period. Submit the ATF, along with your other Progress Report documents,
electronically to Joy Jones at PMNetworkEmail@cdph.ca.gov by April 15, 2009.
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Fields on Sheets to be completed (step-by-step instructions follow):

Objective: Change the sheet names to reflect the Goal # and Objective # from the
SOW. Enter each objective on the appropriate sheet exactly as written in the SOW (cell
C:3 of each objective sheet).

Activity # or Act #: Enter the appropriate activity number from your SOW objective for
the activity completed.

Date: Enter the date for each program activity that took place using the month, day and
year. Do not use date ranges or entire months; list each occurrence of an activity as a

discrete entry.

Describe Activities: Give a brief description of each activity conducted, including
location and age, if appropriate. This is particularly important when the same or similar
interventions are conducted at multiple locations with multiple audiences. The activity
description should be related to your SOW and the same language should be used on
the ATF that is used in the SOW.

o List each activity once only. For trainings for providers or staff, do not extrapolate
reach to the target audience. For example, if training is given to 200 teachers, enter
200 in the Provider/Staff Training Classes column for Section K. Classes. Do not
make another numerical entry under Section K: Classes: Consumer Nutrition
Education Classes, assuming the students will benefit from the teacher training.

o0 When more then one activity occurs on the same day and they have the same
description (topic, location, age), please indicate the time of day the activity took
place so that it does not appear as a duplicate entry.

o If a single activity has multiple topics, it is counted only once. For example, if a
nutrition education newsletter has inserts about physical activity and fruit and
vegetable promotion, distribution of this single package is counted only once as a
Non-SAAR activity, not as three separate activities.

0 Please enter all activities in chronological order by SOW objective/activity. Record
all activities conducted, as part of your Network SOW, from October 1, 2008 through
March 31, 2009. Before printing and submitting your Activity Tracking Form
with your Progress Report, please sort in chronological order by activity (see
instructions under FAQs, question #3).

Number of People Reached: Enter the number of individuals reached for each activity
entered in the appropriate activity-type column (e.g., Farmers’ Market, Taste Test).

Totals: These rows do not have to be manually completed. Entries will automatically
total at the bottom of each sheet. In addition, the cumulative totals for SAAR-related
activities from all sheets will automatically total on the “ATF Summary page.” Enter the
totals from the ATF Summary page and Media Summary page directly into the on-line
SAAR in the appropriate sections. Report the numbers for non-SAAR activities in the
“Progress to Date” column of your Annual Progress Report, if applicable.
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Step-By-Step Instructions

Setting Up/Customizing Your Activity Tracking Form

A. Set worksheet tabs to match your SOW:

1.
2.

3.
4.

Open the Excel spreadsheet.

There are tabs located at the bottom of the screen: sample objective,
Infrastructure, Objective 1-25, ATF Summary page, and Media Summary page.
Click on the tab for Objective 1; this highlights the tab name.

Right click and select “Rename” from the menu.

Rename the tab to reflect Goal 1, Objective 1 (examples: G1.01, or 1.1 — using
a short name for the sheets will allow viewing of all/most tabs on the screen).
See sample below with renamed tabs.

Double click on cell C:3 and enter the text for Goal 1, Objective 1 (you can open
your SOW in Word and copy and paste the text, if desired).

Click on the tab for Objective 2 and repeat steps 4-6. Continue until you have
renamed all of your tabs and entered all of the text for the Goals/Objectives from
your SOW.
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8.

The worksheet labeled “Infrastructure” should be used to track activities related

to your Infrastructure Objective. You may leave the tab name as is or change it
to match the goal/objective numbers in your SOW. Do not change the names of
the Media and ATF Summary pages.

B. Enter your contractor information in the sheet headers:

1.

2.

NoOokow

o

Click on the tab for the first goal/objective or the Infrastructure tab, whichever tab
is furthest to the left (do not select the sample objective).

Use the “»I” button to scroll all the way to the last tab, hold down the Shift key
and click on the ATF Summary page. This will select all sheets except for the
sample objective and the Media Summary page. If you are not using the most
current version of the ATF, it is recommended to move the Media Summary page
so that it is on the right of the ATF Summary Page.

Click on the “View” menu and select “Header and Footer.”

In the “Page Setup” box, click on “Custom Header.”

In the “Left Section” box, complete the lines for Contractor and Contract #.

Click “OK” in the Header box, then click “OK” in the “Page Setup” box.

This will place the information on the header for the ATF Summary page and all
objective sheets.

Repeat steps 3-6 for the Media Summary page separately. Doing so will
preserve the page setup which is slightly different for the Media Summary page.
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C. Entering activities into the ATF sheets:

1. Open the ATF worksheet.

2. Click on the appropriate worksheet tab for the Goal/Objective/Activity you wish to
enter.

3. Click on the first open cell under the heading “Act #.”

4. Enter the activity number from your SOW for that objective.

5. Press the <tab> key to move to the “Date” field; enter the date the activity
occurred.

6. Press the <tab> key to move to the “Activity Description” field; enter the
description of the activity. This should include type of activity, location, grade
level, topic (e.%., Cooking demo and taste testing, Fruit Smoothies, Smith
Elementary, 5" grade).

7. Press the <tab> key (or use the mouse and click on the cell) to move to the
column that best describes the type of activity and enter the number of
individuals reached.

8. The column will automatically total at the bottom of the sheet and on the ATF
Summary page.

Don’t forget to save your work to the hard drive so these changes will not be lost!

Updated November 2008 Page 4 of 8



Frequently Asked Questions (FAQS)

Q1.
Al

Q2.

A2.

Q3.

A3.

Q4.

A4.

Q5.

A5.

How do | add more rows to a worksheet?

To insert one row, select the row or a cell in the row above where you want to
insert the new row (this must be below row 5 and above the totals section). On
the “Insert” menu select “Rows.” One new row will be added. You may also add
multiple rows. For example, if you wish to add 5 rows: select an empty row or
cell, click and hold the left mouse button, move down highlighting 5 rows. On the
“Insert” menu select “Rows” and 5 news rows will be inserted.

How do | count an event that satisfies more than one activity in the SOW
(e.g., activities under two different objectives)?

While this generally should not occur, the number of individuals reached should
only be counted once. Therefore, enter the activity on the worksheets for both
objectives, but enter the total number reached under only one objective. On the
second entry (without the reach numbers) please note in the “Activity
Description” column, along with the activity information, where the reach
numbers were listed (e.g., target reach listed with G1.02.A5).

Activities are entered as they occur and the dates/activities are out of
order. How can | get the entries in chronological order by activity and
date?

To sort your entries by date within activity order, highlight only the rows
containing activities (click on the first row number, hold down the left mouse
button, and move down the page to the last activity. With the rows highlighted,
click on the Data Menu and select Sort. In the “sort by” field, enter “Column A”
(Act # column). In the “then by” field, enter, “Column B” (the Date column). Sort
in ascending order for both fields. Click OK.

How can | use the ATF to track non-SAAR activities?

A set of three columns labeled “Non-SAAR Activities” has been included on the
sheets for objectives 1-25 for you to track SOW activities that are not reported on
the SAAR. These columns will total at the bottom of each page, but will not total
on the ATF Summary page. Column titles have been left blank so that you can
customize to your ATF by adding the names of the appropriate activities.
Examples of activities that would be tracked in the Non-SAAR Activities column
include materials distribution, such as newsletters, planning meetings, and reach
for media activities that are tracked on the media summary page. In addition, a
separate sheet labeled “Infrastructure” has been included for tracking activities
unique to that objective (Collaborative meetings, Network-sponsored trainings,
Annual Conference), since these activities only occur under this objective.

Where would | log newsletters or other materials distributed?

These activities should be tracked under the Non-SAAR activities column for the
corresponding objective. There is a section of the SAAR that collects information
on newly developed materials; however only the title of the material is requested
not the quantity distributed.
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Q6.

AG.

Q7.
AT.

| understand how to use the sheets and no longer need the “sample
objective” sheet. How do I remove it from the spreadsheet?

To remove the “sample objective” worksheet, click on the tab for that sheet. With
the “sample objective” sheet open, click on the Edit menu, then click on “Delete
Sheet.” A prompt box will appear asking you to confirm the deletion. Click on
“Delete.”

| don’t need all of the “objective” sheets. What should | do with the extras?
While you can easily delete the “sample” sheet, please do not delete any extra
objective sheets that you do not need. Doing so invalidates the formulas on the
“ATF Summary” sheet that provide you with your SAAR total numbers. Instead,
after renaming your objective sheets with your SOW goal/objective numbers,
move the “Media Summary” page and the “ATF Summary” page to the end of
your customized goal/objective sheets. To do this, click on the “Media Summary”
sheet, hold down the Ctrl key, and then click on the “ATF Summary” sheet. This
will highlight both sheets (tabs will turn white). Click on either of these sheets
and, holding down the left mouse button, move the sheets to the space between
your last goal/objective sheet and the remaining, unneeded objective sheets.
Release the mouse. See example of finished product below.
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Q8.
A8.

Qo.

A9.

| have more than 25 objectives. How can | add more sheets?

Adding more sheets requires some revisions to the ATF Summary sheet. Since
few contractors have more than 25 objectives in their SOW, these requests will
be handled on a case-by-case basis. Please contact your Program Manager for
assistance.

| have staff (or subcontractors) who work offsite and keep their own ATF.
How can | combine their activity entries with the master ATF?

After completing the customization steps A. and B. above, you may send a copy
of the ATF as an email attachment to staff or subcontractors working in other
locations (field offices). During the reporting period, Network staff in your various
offices can enter activities into their separate worksheets, while the master
worksheet is maintained at the main Network office. At the end of the reporting
period, have staff return the completed ATF (again, as an email attachment). To
compile activities into one ATF for Progress Report submission, follow these
steps:

1. Save the field office ATF to the hard drive (giving a different name than your
master ATF worksheet).

2. Open both the master and field office ATF worksheets.

3. In the first objective sheet of the field worksheet, click on the first activity row
number (this should be row 5). The entire row will be highlighted.
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Q10.

A10.

Q11.
All.

4. Hold down the left mouse button and move down to the last activity to be

copied.

Right click and select “Copy.”

In the matching objective sheet on the master ATF, click on the first empty

row.

7. Right click and select “Insert Copied Cells.”

8. Repeat steps 3-7 for each objective.

9. When complete, use the sorting instructions above to place all activities in
activity/date order.

10. Save your changes.

o o

| have events that occur daily and span a significant period of time (e.g., an
entire month or daily through the school semester). Must each day be
listed on the ATF, or can the target audience numbers for the
campaign/activity be totaled and listed once when the activity ends?
Campaigns and events that occur at a specific site over a period of time may be
listed as a single event, using the ending date of the event/campaign as the date
for the entry. The event name, site/location, and beginning and ending dates
should be included in the “Activity Description” column (Column C). For events,
campaigns, and activities that occur at multiple sites, each site must be listed
separately. To ensure an accurate count of the target audience reached, the
Contractor must keep on file a tally or sign in sheet for each day’s attendance (do
not submit these with your ATF or Progress Report).

Examples of events that would fall in this category include:

¢ A month-long cafeteria campaign at a school site (requires daily estimate of
students reached). List each school site separately.

e Student Nutrition Advisory Councils that meet daily (5 days/week) throughout
the semester (requires daily sign in sheet). List each school site separately.

e A summer cooking camp that meets daily for multiple weeks (requires daily
sign in sheet).

Events that meet on a weekly basis with varied nutrition and physical activity
topics should be listed on the ATF by each occurrence of the class, indicating the
week’s topic. Examples include:

e A 5-class nutrition education series that meets once weekly.
e Student Nutrition Advisory Councils that meet weekly or bi-weekly.
e Events, campaigns, nutrition education series of short duration (1-2 weeks).

If you have questions regarding a specific activity, please contact your assigned
Program Manager.

Can | track reach for activities that involve Power Play activities and are
being counted by the Regional Power Play representative?

Yes. This would NOT be considered duplicated reporting. The number of
children reached and number of impressions generated using the Idea &
Resource Kits in a Local Incentive Awardee (LIA) site may be reported by both
the LIAs and regional Children’s Power Play! Campaign. As part of their
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Q12.

Al2.

Q13.

A13.

Q14.

Al4.

Q15.

Al5.

reporting, the Children’s Power Play! Campaign regional staff indicates which
reported numbers are also being reported by an LIA. Prior to sharing the
Children’s Power Play! Campaign numbers with the USDA, we are able to
determine the percentage that has also been reported by LIAs.

It is important to note that the regional Children’s Power Play! Campaign relies
upon the numbers reported to them by the LIAs to demonstrate that they have
met their contract objectives. If LIAs use the Children’s Power Play! Campaign’s
Idea & Resource Kits, but do not share data with the regional staff, the region
may fall short of their objectives, which are calculated based upon the total
number of eligible children in the region (including those in LIA sites).

My totals rows do not seem to be adding up correctly when | add or delete
numbers. Why is this happening?

This could be happening for several reasons. The first thing to check would be
the Calculation setting. To do this click on “Tools” then select “Options.” In the
“Options” dialog box, click on the “Calculation” tab. Under the Calculation section
make sure that the option of “Automatic” is selected. Another explanation could
be the formulas in the totals row have been disrupted or rows were added on row
5.

If the primary emphasis of a class is on nutrition but we promote physical
activity, would | track those activities under the PA with Nutrition Education
category?

Yes. If the nutrition education class includes physical activity promotion it should
be tracked under PA with Nutrition Education. If there is no physical activity
promotion then it should be tracked under Consumer Nutrition Education Class.

Where would | track meetings that are conducted as part of an objective
activity and are not related to the Infrastructure Objective?

Meetings that are part of your SOW but do not apply to your Infrastructure
Objective should be tracked under the Non-SAAR Activities column for that
specific objective. An example of such a meeting might include an event
planning meeting.

Where would I log training for community members that are not staff or
providers (e.g., parents or Promotoras participating in a train-the-trainer
program)?

When training is conducted for FSNE intermediaries with the intention that they
will use what they learn to teach FSNE eligibles, the reach should be tracked
under the Provider/Staff Training column under section K. Classes. In this
instance they would be considered Para-Professionals. If the parents or
Promotoras are participating in a workshop or class but there is no expectation
that they will use what they learn to teach FSNE eligibles, the reach should be
tracked under the column that best describes the activity.
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